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MCP9800 THERMAL SENSOR PICtail™
DEMO BOARD USER’S GUIDE
Preface
INTRODUCTION

This chapter contains general information that will be useful to know before using the 
MCP9800 Thermal Sensor PICtail Demo Board. Items discussed in this chapter 
include:

• About This Guide
• Recommended Reading
• The Microchip Web Site
• Customer Support

ABOUT THIS GUIDE

Document Layout

This document describes how to use the MCP9800 Thermal Sensor PICtail Demo 
Board as a development tool to emulate and debug firmware on a target board. The 
manual layout is as follows:

• Chapter 1: Overview – Important information about the MCP9800 Thermal 
Sensor PICtail Demo Board.

• Chapter 2: MCP9800 Thermal Sensor PICtail Demo Board – Includes a 
detailed description of each function of the demo board and instructions on how to 
begin using the board.

• Appendix A: Schematic and Layouts – Shows the schematic and layout 
diagrams for the MCP9800 Thermal Sensor PICtail Demo Board.

• Appendix B: Bill-of-Materials (BOM) – Lists the parts used to build the 
MCP9800 Thermal Sensor PICtail Demo Board.

NOTICE TO CUSTOMERS

All documentation becomes dated, and this manual is no exception. Microchip tools 
and documentation are constantly evolving to meet customer needs, so some actual 
dialogs and/or tool descriptions may differ from those in this document. Please refer 
to our web site (www.microchip.com) to obtain the latest documentation available.

Documents are identified with a “DS” number. This number is located on the bottom 
of each page, in front of the page number. The numbering convention for the DS 
number is “DSXXXXXA”, where “XXXXX” is the document number and “A” is the 
revision level of the document.

For the most up-to-date information on development tools, see the MPLAB® IDE 
on-line help. Select the Help menu, and then Topics to open a list of available on-line 
help files.
© 2005 Microchip Technology Inc. DS51528A-page 1
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Conventions Used in this Guide

This manual uses the following documentation conventions:

RECOMMENDED READING

The following Microchip document is available and recommended as a supplemental 
reference resource.

MCP9800, “2-Wire High-Accuracy Temperature Sensor” Data Sheet (DS21909)

This data sheet provides detailed information regarding the MCP9800 device.

DOCUMENTATION CONVENTIONS
Description Represents Examples

Arial font:
Italic characters Referenced books MPLAB® IDE User’s Guide

Emphasized text ...is the only compiler...
Initial caps A window the Output window

A dialog the Settings dialog

A menu selection select Enable Programmer
Quotes A field name in a window or 

dialog
“Save project before build”

Underlined, italic text with 
right angle bracket

A menu path File>Save

Bold characters A dialog button Click OK
A tab Click the Power tab

‘bnnnn A binary number where n is a 
digit

‘b00100, ‘b10

Text in angle brackets < > A key on the keyboard Press <Enter>, <F1>
Courier font:
Plain Courier Sample source code #define START

Filenames autoexec.bat

File paths c:\mcc18\h

Keywords _asm, _endasm, static

Command-line options -Opa+, -Opa-

Bit values 0, 1

Italic Courier A variable argument file.o, where file can be 
any valid filename

0xnnnn A hexadecimal number where 
n is a hexadecimal digit

0xFFFF, 0x007A

Square brackets [ ] Optional arguments mcc18 [options] file 
[options]

Curly brackets and pipe 
character: { | }

Choice of mutually exclusive 
arguments; an OR selection

errorlevel {0|1}

Ellipses... Replaces repeated text var_name [, 
var_name...]

Represents code supplied by 
user

void main (void)
{ ...
}

DS51528A-page 2 © 2005 Microchip Technology Inc.



Preface
THE MICROCHIP WEB SITE

Microchip provides online support via our web site at www.microchip.com. This web 
site is used as a means to make files and information easily available to customers. 
Accessible by using your favorite Internet browser, the web site contains the following 
information:

• Product Support – Data sheets and errata, application notes and sample 
programs, design resources, user’s guides and hardware support documents, 
latest software releases and archived software

• General Technical Support – Frequently Asked Questions (FAQs), technical 
support requests, online discussion groups, Microchip consultant program 
member listing

• Business of Microchip – Product selector and ordering guides, latest Microchip 
press releases, listing of seminars and events, listings of Microchip sales offices, 
distributors and factory representatives

CUSTOMER SUPPORT

Users of Microchip products can receive assistance through several channels:

• Distributor or Representative
• Local Sales Office
• Field Application Engineer (FAE)
• Technical Support
• Development Systems Information Line

Customers should contact their distributor, representative or field application engineer 
(FAE) for support. Local sales offices are also available to help customers. A listing of 
sales offices and locations is included in the back of this document.

Technical support is available through the web site at: http://support.microchip.com

In addition, there is a Development Systems Information Line which lists the latest 
versions of Microchip’s development systems software products. This line also 
provides information on how customers can receive currently available upgrade kits.

The Development Systems Information Line numbers are: 

1-800-755-2345 – United States and most of Canada

1-480-792-7302 – Other International Locations

REVISION HISTORY

Revision A (January 2005)

• Initial Release of this document.
© 2005 Microchip Technology Inc. DS51528A-page 3
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MCP9800 THERMAL SENSOR PICtail™
DEMO BOARD USER’S GUIDE
Chapter 1.  Product Overview
1.1 INTRODUCTION

This chapter provides an overview of the MCP9800 Thermal Sensor PICtail Demo 
Board and covers the following topics:

• What is the MCP9800 Thermal Sensor PICtail Demo Board?
• What the MCP9800 Thermal Sensor PICtail Demo Board kit includes

1.2 WHAT IS THE MCP9800 THERMAL SENSOR PICtail DEMO BOARD?

The MCP9800 Thermal Sensor PICtail Demo Board demonstrates how to interface the 
MCP9800 to a PICmicro® microcontroller using the PICkit™ 1 Flash Starter Kit as a 
platform. A PIC16F684 14-pin, Flash-based, 8-bit CMOS microcontroller device is 
included with the demo board and can be used with PICkit 1 Flash Starter Kit. Also 
included is firmware that provides the I2C™ interface and temperature conversion 
routines to communicate with the MCP9800 and convert the serial data to temperature.

The MCP9800 Thermal Sensor PICtail Demo Board can also be used as a 
“stand-alone” module to quickly add thermal-sensing capability to any existing 
application. This basic sensor functionality is implemented on a small Printed Circuit 
Board (PCB) and an interface via a standard 100 mil header.

1.3 WHAT THE MCP9800 THERMAL SENSOR PICtail DEMO BOARD KIT 
INCLUDES

This MCP9800 Thermal Sensor PICtail Demo Board Kit includes:

• The MCP9800 Thermal Sensor PICtail Demo Board
• MCP9800 Thermal Sensor PICtail Demo Board User’s Guide
• MCP9800 Data Sheet
• PIC16F684 14-pin, Flash-based, 8-bit, CMOS Microcontroller
• PIC16F684 Firmware
© 2005 Microchip Technology Inc. DS51528A-page 5
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MCP9800 THERMAL SENSOR PICtail™
DEMO BOARD USER’S GUIDE
Chapter 2.  Installation and Operation
2.1 INTRODUCTION

The MCP9800 Thermal Sensor PICtail Demo Board demonstrates how to interface the 
MCP9800 to a microcontroller, for use by the system designer as an example of how 
to integrate a digital temperature sensor into a system. In addition, the designer can 
serially transmit the temperature data to the onboard, 7-segment LED display to show 
the temperature.

2.2 FEATURES

The MCP9800 Thermal Sensor PICtail Demo Board has the following features:

• Small PCB layout
• Standard 100 mil 14-pin header (J2) for easy interface to the PICkit™ 1 Flash 

Starter Kit or custom application
• 7-segment LED display to display temperature in °C or °F
• Temperature alert-indicating LED

2.3 GETTING STARTED

This section describes how to quickly configure the MCP9800 Thermal Sensor PICtail 
Demo Board and PICkit™ 1 Flash Starter Kit. A block diagram of the configuration is 
shown in Figure 2-1.

FIGURE 2-1: MCP9800 Thermal Sensor PICtail™ Demo Board Block Diagram.
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MCP9800 Thermal Sensor PICtail™ Demo Board User’s Guide
2.3.1 Hardware Setup

1. Connect the J2 header of the MCP9800 Thermal Sensor PICtail Demo Board to 
the J3 connector on the PICkit™ 1 Flash Starter Kit. Refer to Figure 2-2 for 
proper orientation of the MCP9800 Thermal Sensor PICtail Demo Board and 
Figure 2-3 for a simplified board schematic.

2. Insert the PIC16F684 into the evaluation socket of the PICkit 1 Flash Starter Kit.
3. Connect the PICkit 1 Flash Starter Kit USB cable from the USB port of the PC to 

the USB port (J1) on the PICkit 1 Flash Starter Kit. +5V of power is supplied to 
the PICkit 1 Flash Starter Kit via the USB cable. The green power LED and the 
red busy LED will turn on, indicating that power is being supplied to the board.

FIGURE 2-2: MCP9800 PICtail™ Daughter Board and PICkit™1 Flash Starter Kit.

FIGURE 2-3: Simplified MCP9800 PICtail™ Daughter Board Schematic.

WARNING

Do not hot-swap the MCP9800 PICtail™ Demo Board.
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Installation and Operation
2.3.2 Programming the PIC16F684

1. Download and install the PICkit 1 Flash Starter Kit software onto your PC.
2. Copy the 00031R1-1.HEX file (supplied on the CD that came with this kit) onto 

your PC.
3. When the PICkit 1 Flash Starter Kit is started, the main window will be displayed 

on the PC, as indicated in Figure 2-4.

 

FIGURE 2-4: PICkit™ 1 Flash Starter Kit GUI Window on the PC.

4. Switch off the device power by unchecking the Device Power box under Board 
Controls in the PICkit 1 Flash Starter Kit window (Figure 2-4). The busy LED on 
the PICkit 1 Flash Starter Kit will switch off when the device power is switched off.

5. Click on the Erase button in the window to ensure that the PIC16F684 device has 
been erased.

6. From the File pull-down menu, select Import HEX. A file window will appear. 
Select and open 00031R1-1.HEX.

7. Click on the Write Device button in the PICkit 1 Flash Starter Kit window. The 
PIC16F684 device will be written to with the 00031R1-1.HEX firmware. Once 
completed, the status bar at the bottom of the window will indicate Write 
Successful.

8. Switch on the device power by checking the Device Power box under Board 
Controls in the PICkit 1 Flash Starter Kit window. The busy LED on the PICkit 1 
Flash Starter Kit will turn on when the device power is switched on. 

9. The 7-segment display on the MCP9800 Thermal Sensor PICtail Demo Board 
will show ambient temperature (°C).
© 2005 Microchip Technology Inc. DS51528A-page 9
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2.4 FUNCTIONAL DESCRIPTION

2.4.1 The MCP9800 Thermal Sensor PICtail™ Demo Board

This demo board has the MCP9800 temperature sensor device and a 7-segment LED 
display circuit. The user can read the ambient temperature data from the MCP9800 
using the PICkit 1 Flash Starter Kit and display the data using the 7-segment display 
on the MCP9800 Thermal Sensor PICtail Demo Board. It’s also possible to transmit the 
data to a PC for a display using the PICkit 1 Flash Starter Kit software strip-chart 
display tool.

This demo board has a 14-pin header that connects to the PICkit 1 Flash Starter Kit. 
The header connects the +5V supply, ground and all serial I/O pins to the MCP9800 
Thermal Sensor PICtail Demo Board. There are four serial I/O lines used to communi-
cate with the MCP9800 and the 7-segment display circuit. The MCP9800 uses two I/O 
lines for the I2C™ interface to transmit temperature data, while the 7-segment display 
circuit uses two I/O lines for the SPI™ interface to display temperature data.

The user can develop custom firmware to communicate with the MCP9800 and the 
7-segment display using most 14-pin PICmicro® microcontrollers and the PICkit 1 
Flash Starter Kit. In addition, Microchip provides a demo firmware that uses the 
PIC16F684 microcontroller. This firmware will be referenced throughout the user’s 
guide to show the various functions of the demo board.

2.4.2 The MCP9800

The MCP9800 comes with user-programmable registers that provide flexibility for 
temperature-sensing applications. The register settings allow user-selectable 9-bit to 
12-bit temperature measurement resolution, configuration of the power-saving 
Shutdown and One-shot (single conversion on command while in Shutdown) modes 
and the specification of both temperature alert output and hysteresis limits. When the 
temperature changes beyond the specified limits, the MCP9800 outputs an alert signal. 
The user has the option of setting the alert output signal polarity as an active-low or 
active-high comparator output for thermostat operation, or as a temperature event 
interrupt output for microprocessor-based systems 

This device has I2C/SMBus compatible serial interface (refer to the MCP9800 data 
sheet (DS21909) for further details).
DS51528A-page 10 © 2005 Microchip Technology Inc.



Installation and Operation
2.4.3 User-Selectable Features

The demo firmware programs the Temperature Limit and Hysteresis Limit registers 
(TSET and THYST, respectively) according to the position of the RP1 potentiometer, 
located on the PICkit 1 Flash Starter Kit. The potentiometer is connected to the 
PIC16F684 analog input pin. The voltage across the potentiometer wiper terminal 
determines TSET.  The wiper position provides 15 possible TSET limits from 10°C to 
55°C, in 3°C increments. THYST is programmed 5°C below TSET (5°C hysteresis).

When the ambient temperature exceeds the programmed TSET limit, the MCP9800 
outputs an alert signal using the ALERT output pin. This pin is an open-drain output that 
is configured as an active-high output. When this pin is high, the D1 diode lights up and 
remains lit until the temperature drifts beyond the hysteresis limit (THYST).

This firmware also converts degree Celsius to degree Fahrenheit using the SW1 switch 
located on the PICkit 1 Flash Starter Kit. When the user presses the momentary 
push-button switch, the 7-segment display shows the ambient temperature in degree 
Fahrenheit.

In addition, the user has the option of changing the MCP9800 temperature measure-
ment resolution (default resolution is 10-bit). However, this requires modifying a firm-
ware variable and recompiling the firmware. The 00031R1-1.asm firmware can be 
edited and compiled using Microchip’s MPLAB® IDE, which can be downloaded from 
Microchip’s web site at www.microchip.com. This particular variable is identified in text 
within the firmware, with an instruction provided about how to change the variable to 
select a resolution. Once the variable is changed according to the instruction given in 
the 00031R1-1.asm firmware, the user can recompile the firmware and program the 
PIC16F684 with the 00031R1-1.HEX file, as shown in Section 2.3.2 “Programming 
the PIC16F684”.

This demo board and demo firmware provides a platform to easily develop a custom 
firmware and evaluate the various features of the MCP9800.
© 2005 Microchip Technology Inc. DS51528A-page 11
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2.4.4 Displaying the Temperature Data

2.4.4.1 THE 7-SEGMENT LED DISPLAY

The PIC16F684 microcontroller firmware, located on the PICkit 1 Flash Starter Kit, 
reads the ambient temperature from the MCP9800 temperature sensor and sends the 
data to the 7-segment LED display.

The 7-segment LED display is controlled using another PICmicro® microcontroller that 
is located on the MCP9800 Thermal Sensor PICtail Demo Board. This PICmicro 
microcontroller controls the LED segments and display frequency. It receives data from 
the PICkit 1 Flash Starter Kit using ports RC3 and RC5 via the SPI protocol. Once the 
data is successfully received, the PICmicro microcontroller displays the corresponding 
LED segments.

The temperature data from the PICkit 1 Flash Starter Kit has to be formatted to Binary 
Code Decimal (BCD) before transmission. A 4-bit instruction and a 4-bit BCD has to be 
transmitted for each of the four digits on the 7-segment display. The location and 
definition of the instruction bits and BCD bits are shown in Table 2-1. 

TABLE 2-1: SERIAL DATA FORMAT       

This format requires that a 32-bit data (8 bits at a time) needs to be transmitted in order 
to display four-digit temperature data on the 7-segment display. 

Table 2-2 shows examples on displaying temperature data.

TABLE 2-2: TEMPERATURE DATA FORMAT FOR DISPLAY 

This format insures proper protocol between the microcontrollers on the PICkit 1 Flash 
Starter Kit and the MCP9800 Thermal Sensor PICtail Demo Board. In addition, this 
display protocol makes the 7-segment display circuit generic for use in applications 
other than temperature data display. 

Instruction BCD

Start Dot No display Dash MSb                                                LSb

bit 7 bit 0

bit 7 START: Start-of-display bit

1 = This BCD is the first digit
0 = This BCD is not the first digit

bit 6 DOT: Display dot bit
1 = Display dot after this BCD, which indicates that the next BCD is a decimal point
0 = No dot displayed

bit 5 NO DISPLAY: No digit to be displayed
1 = Digit not displayed
0 = Digit displayed

bit 4 DASH: Display dash for negative number bit

1 = Display dash (—) to indicate negative number.
0 = Dash not displayed

bit 3 - 0 BCD: BCD bits MSb first

Temperature 1st byte 2nd byte 3rd byte 4th byte

125.5 1000 0001 0000 0010 0100 0101 0000 0101

25.25 1000 0010 0100 0101 0000 0010 0000 0101

 5.25 1010 0000 0100 0101 0000 0010 0000 0101

-5.25 1001 0000 0100 0101 0000 0010 0000 0101

-55.5 1001 0000 0000 0101 0100 0101 0000 0101
DS51528A-page 12 © 2005 Microchip Technology Inc.



Installation and Operation
The 7-segment display controller firmware (00031R1-2.HEX) can be customized 
using Microchip’s MPLAB® ICD 2 programming tool. A header can be soldered on the 
MCP9800 Thermal Sensor PICtail Demo Board for the MPLAB ICD 2 programmer. The 
PIC16F737 microcontroller cannot be programmed using the PICkit 1 Flash Starter Kit. 

2.4.4.2 STRIP-CHART DISPLAY ON PC

Once the hardware is connected to the PICkit 1 Flash Starter Kit, as shown in Section 
2.3.1 “Hardware Setup”, and the PIC16F684 MCU is programmed as indicated in 
Section 2.3.2 “Programming the PIC16F684”, the user can use the strip-chart tool 
available on the PICkit 1 Flash Starter Kit software. This is done by selecting the strip-
chart tool on the software and clicking GO. 

The strip-chart display shows the ambient temperature data from the MCP9800. This 
display does not support negative numbers. Therefore, the data is offset by 1024. In 
addition, the tool does not support 11-bit and 12-bit data.
© 2005 Microchip Technology Inc. DS51528A-page 13
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MCP9800 THERMAL SENSOR PICtail™
DEMO BOARD USER’S GUIDE
Appendix A. Schematic and Layouts
A.1 INTRODUCTION

This appendix contains the following schematics and layouts for the MCP9800 Thermal 
Sensor PICtail Demo Board:

• Board Schematic
• Board - Top Layer
• Board - Silk-Screen Layer
• Board - Bottom Layer
© 2005 Microchip Technology Inc. DS51528A-page 15
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A.2 BOARD SCHEMATIC

T
M

DS51528A-page 16 © 2005 Microchip Technology Inc.



Schematic and Layouts
A.3 BOARD - TOP LAYER
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A.4 BOARD - SILK-SCREEN LAYER  
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Schematic and Layouts
A.5 BOARD - BOTTOM LAYER
© 2005 Microchip Technology Inc. DS51528A-page 19
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MCP9800 THERMAL SENSOR PICtail™
DEMO BOARD USER’S GUIDE
Appendix B. Bill-Of-Materials (BOM)
TABLE B-1: BILL-OF-MATERIALS (BOM)

Qty Reference Description Manufacturer Part Number

1 C1 CAP .1 µF 16V CERAMIC X7R 0805 Panasonic® - ECG ECJ-2VB1C104K

1 C2 CAP 4.7 µF 6.3V CERAMIC 0805 X5R Panasonic - ECG ECJ-2FB0J475M

2 C3,C4 CAP 1 µF 16V CERAMIC Y5V 0805 Panasonic - ECG ECJ-2VF1C105Z

1 D1 LED 2.8X3.2 MM 635NM RED CLR SMD Panasonic - ECG SML-LX2832IC-TR

1 LED1 LED 7-Segment  .4" 4DGT SUPER RED CA Panasonic - ECG LTC-4627JR

1 R3 RES 1.00 KΩ 1/10W 1% 0805 SMD Panasonic - ECG ERJ-6ENF1001V

6 R1,R2,R10, 
R11,R12,R13

RES 10.0 KΩ 1/10W 1% 0805 SMD Panasonic - ECG ERJ-6ENF1002V

1 R8 RES 20.0 KΩ 1/10W 1% 0805 SMD Panasonic - ECG ERJ-6ENF2002V

5 R3,R4,R5,R6 R7 RES 100Ω 1/10W 1% 0805 SMD Panasonic - ECG ERJ-6ENF1000V

1 R9 RES 475Ω 1/10W 1% 0805 SMD Panasonic - ECG ERJ-6ENF4750V

1 J1 CONN MOD JACK 6-6 R/A PCB 50AU                                                 
* * Note:   "NOT POPULATED"

Panasonic - ECG 520470-3

1 J2 CONN HEADER 14POS .100 VERT TIN Panasonic - ECG 22-28-4140

U1 2-Wire High-Accuracy Temperature Sensor Microchip
Technology Inc.

MCP9800AOT-M/TOG

U2 8-Bit CMOS Flash Microcontroller Microchip
Technology Inc.

PIC16F737-I/SO

U3 Logic-Input CMOS Quad Drivers Microchip
Technology Inc.

TC4469COE
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